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INTRODUCTION

En 2009, Miguel Lescano démarrait un sujet sur SketchUcation a propos
de sa découverte étonnante en utilisant SketchUp. C'est devenu
affectueusement un fil de de discussion appelé "The D'oh! Thread" et
au fil des années d'interventions c'est devenu le lieu secret sur Internet
pour partager vos étonnements avec SketchUp.

Ce qui a commencé comme la plus honnéte des Confessions s'est biento6t
transformée en un trésor de conseils et de techniques de tueurs pour
SketchUp.

Ce livre est dédié a tout ceux qui ont partagé leurs moments de Oh! pour
I'enseigner aux autres.

COMMENT UTILISER CE LIVRE

Le Livre Des Oh! ne contient pas de chapitres, de sections ou de modéle
logique. Vous pouvez picorer, ouvrir une page pour en savoir plus sur
guoi que ce soit a partir des conseils et des techniques cachées depuis la
nuit des temps.

Partout ou vous irez vous apprendrez quelque chose de nouveau a
propos de SketchUp.

Si vous voulez contribuer avec votre propre Oh! envoyez un email a
support@sketchucation.com et nous mettrons votre Oh! dans les
prochaines mises a jours.
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Remerciements

Ce livre n'aurait pas été possible sans la communauté dynamique et
sympathique contribuant a SketchUcation. Donc Merci au 445 820
d’entre vous!

Mais nous aimerions dire un merci trés spécial a ceux qui ont partagé
un Oh! attaché a jamais a I'histoire de I'Internet. Nous avons fait de
notre mieux pour visualiser ainsi votre Oh! pour qu'il soit compris et
partagé avec d'autres.

Pour aider a la compilation du livre, nous voulons donner un viva vibrant
a Dave Richards et Thomas Thomassen. Non seulement des Légendes
parmi la communauté SketchUp, mais aussi de bons relecteurs! Merci
les gars!

Enfin, nous tenons a remercier toute I'équipe de SketchUp. Sans eux il
n'y aurait pas eu de moments de Oh!

Comme la plupart des utilisateurs de logiciels de CAO, nous avons
tendance a ignorer les manuels de I'utilisateur et menons notre chemin
de concepteur 3D a la Force Brute .

SketchUp a fait une application qui non seulement nous a permis de
modéliser cette conception sans le manuel mais aussi de le faire dans un
magnifique environnement.

Rich O'Brien | Directeur Général
Sketchucation LLC
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L'Outil Déplacer (Move Tool)

“Je viens de réaliser que I'Outil Déplacer propose une fonction de
rotation lorsque vous sélectionnez un composant ou groupe. Passez
simplement votre souris sur I'une des six faces de la boite englobante et
vous verrez quatre croix rouges. Sélectionnez I'une d'entre elles et votre
composant tournera autour de son centre."

Miguel Lescano - www.arqui3d.com

Astuce: Essayez de survoler les graduations incrémentées sur le

rapporteur pendant la rotation pour s'accrocher a des angles de 15°
d'intervalle.
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L'Outil Sélectionner (Select Tool)

"J'ai découvert que le Triple Clic sur une géométrie sélectionnait toutes
les géométries connectées."

Il faut étre rapide! ;)

Pilou

Astuce : Un Double Clic sur une face sélectionnera la face et les arétes
attenantes.

Bonus : Tenir CTRL ajoutera une sélection et CTRL + MAJ retirera cette
sélection.
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Le Menu Contextuel (Context Menu)

"L'option "Orienter les Faces" lorsque vous sélectionnez une face avec
un Clic Droit "Oriente" toutes les faces de I'objet de fagon similaire."

Pilou
Entity Info

Erase
Hide

Select >
Area >
Intersect Faces >

Align View '
Align Axes

Reverse Faces

Zoom Selection

Astuce: SketchUp vous permet de changer la couleur par défaut du
matériau. Allez a la boite de dialogue Styles >Edition> Parameétres de
Face pour changer la couleur de la face arriere en une couleur bien
criarde.

Cela rend plus facile la visualisation de faces inversées lorsque

vous Basculer Menu Affichage > Style de Face> Monochrome. (ou
derniere icone de la barre d'Outil Styles qui affiche les objets avec les
couleurs recto/verso)
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L'Outil Orbite (Orbit Tool)

"J'ai commencé avec avec SketchUp 4, au moment ou j'utilisais une
souris optique de précision qui avait 4 boutons (pas de molette de
défilement), de sorte qu'a la mi Version 5 quand je suis arrivé avec une
souris laser avec une molette de défilement j'ai réaliser qu’on pouvait la
presser pour obtenir I'Orbite .... Maintenant je modélise 10 fois plus
rapidement."

Solo www.solos-art.com

Astuce : Tenir MAJ pendant la pression de la molette bascule en Mode
Panoramique.

Bonus : Tenir CTRL suspendra la gravité, ce qui veut dire qu'il faudra
vous tenir a votre fauteuil!


http://www.solos-art.com/
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L'Outil Suivez-moi (Follow me Tool)

J'ai découvert que I'Outil Suivez-moi pouvait faire un tour - donc aussi
faire un déme. Jusque-la je I'avais construit manuellement - piece par
piece - et avais été si fier de mon D6me cousu-main que je I'ai méme
partagé dans la Banque d'images 3D au profit de "la communauté" et
attendait des salves d'applaudissements qui finalement ne vinrent
jamais."

Gaieus www.gaieus.hu

Astuce : Pré-sélectionnez le chemin que vous voulez suivre puis
sélectionnez la surface du profil pour que SketchUp sache ou aller.
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Chargez des Outils pour SketchUp

Accédez a plus de 800 Extensions Gratuites pour Sketchup
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Les Axes

“Mon plus grand Oh fut d’apprendre que je pouvais changer les axes. Je

dessinais alors un dépo6t de chemin de fer pour Google Earth qui était
hors axe.

"Je me suis battu avec SketchUp pendant deux jours pensant qu'il y
avait quelque chose qui n'allait pas avec le programme ...Il s'est avéré
gue c'était moi ".

Museummaker

: | Place

Move
Reset
Align View
Hide

Astuce : Clic Droit sur n'importe quel des axes Sketchup pour accéder
aux fonctions Placer et Déplacer.
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Le Métre a Ruban (Tape Measure Tool)

"J'ai réalisé que I'Outil Métre a Ruban pouvait étre utilisé pour
redimensionner un modele"

Thomthom www.thomthom.net

/

Astuce : Cliquez sur le point de départ puis le point final pour mesurer
une distance. Tapez ensuite la distance désirée et Boom! votre modele
va se redimensionner.

En utilisant cette fonction a l'intérieur d’un composant ou d’un groupe, seul ce
composant ou ce groupe sera redimensionné.

12
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L'Outil Déplacer (Move Tool)

J'ai réalisé que I'on pouvait changer le rayon d'un cercle qui avait été
extrudé."

Thomthom www.thomthom.net

Astuce : Utilisez I'Outil Déplacer pour trouver le point Cardinal sur le
Cercle. Vous reconnaitrez le point Cardinal car le cercle ne sera plus en
surbrillance. Cliquez et déplacer pour redimensionner le Cercle.

13
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La Barre d'Espace

“Appuyer sur la Barre d'Espace désactive I'Outil actuellement
sélectionné"

Pilou

Image avec la courtoisie de Threadless.com

Astuce : |la Barre d'Espace active I'Outil de Sélection. Utiliser I'outil
de sélection annule I'outil précédent et/ou I'action de cet outil.

14
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Le Menu Contextuel (Context Menu)

'L'utilisation des groupes pour la premiére fois a été un grand pas pour
moi. J'ai passé trop de temps a bidouiller pour essayer d'obtenir des
géomeétries qui ne collaient pas avant cela."

Remus

b il

Astuce : Sélectionnez la géométrie que vous voulez grouper et Clic
Droit pour voir Créer un Groupe dans le Menu Contextuel. Vous
pouvez également transformer la géométrie en Composant en utilisant
la méme technique.

15
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L'Outil Cercle (Circle Tool)

“Un grand moment de Oh! pour moi a été quand quelqu’un d’autre pas
tellement plus famillier avec Sketchup a entré 5 pour le nombre de cotés
de outil cercle, créant ainsi un pentagone parfait! "

HFM

Astuce : Quand vous dessinez un Cercle vous pouvez utilisez CTRL +
+/- sur votre clavier numérique pour définir le nombre de segment du
Cercle. La méme chose peut étre faite avec les Arcs de Cercles.

Il est préférable d’utiliser I'outil Polygone si vous voulez créer des ...Polygones ! Et ainsi
conserver le réglage du nombre de segments habituels pour le cercle

16



SketchUcation’s e The d’'Oh ! Book for SketchUp

L'outil Modeler (Smoove Tool)

L'Outil "Modeler" peut étre utilisé avec des formes autres que
circulaires ... il suffit de sélectionner des sommets avec votre souris puis
d'utiliser I'outil modeler. Jouez avec la taille du cercle de modelage pour
voir comment cela affecte la zone sélectionnée.

NewOne

Astuce : I'0Outil Modeler se trouve dans Menu Outil> Bac a Sable
(Sand Box)

17
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Le Dépot 3D (3DWareHouse)

"Saviez-vous que vous pouvez glisser et déposer un modele a partir
d'images 3D. Cela sauve du temps passé a faire des aller et retours en
essayant de trouver le bon modele."

Andrew Dwight www.plusspec.com

|
|

R seacn Q| Sgn

Astuce : Si vous définissez le Navigateur de Composants dans
SketchUp pour afficher les détails, vous verrez une image miniature, le
nom du modele en bleu et le nom de I'auteur en vert. Si vous cliquez sur
la vignette, elle téléchargera le modele dans SketchUp. Si vous cliquez
sur le nom du modeéle, il affiche le modele dans une fenétre du
navigateur et si vous cliquez sur le nom de l'auteur, il affichera tous les
modeles de I'auteur dans une fenétre du navigateur.

18
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Le Glisser et Déposer (Drag and Drop)

“Je partage un moment étonnant avec vous. Mon enfant avait 11 ans au
moment de lui enseigner les tenants et les aboutissants de SketchUp
quand un jour je lui apprenais comment cartographier les textures sur
une sphere.

Je lui ai demandé trouver une image de la carte de la terre dans notre
dossier de texture du serveur, il a ouvert le dossier sur le second
moniteur et I'a trainé sur la sphere, je m'exclamais "Qu'est-ce tu fais que
sur terre” Mais avant que je puisse terminer ma phrase avec le trop
familier "quel ane! La texture a été mappée sur la sphere. Bien s(r, il n'a
pas mappé correctement en UV mais je ne savais pas que c'était
possible. Sagement il a répondu "comme dans tous les films de karaté,
I'étudiant avec suffisamment de pratique devient le maitre."

Solo www.solos-art.com

Picture Tools

Home Share View Manage ~ @

5] E || =

Panes Views Current Show/ Options
»* > view~ hidev >

Layout

« v A4 || | « Pictu.. » Screensh... v O Search Screens.. P
.—._l.
[ ¥
ARSI o]
Titem  1item selected 788KB Bz
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Passer en Version Premium

En mettant a jour votre compte a sketchucation.com cela vous permet
d'accéder

a un trésor de rabais sur les extensions de haute qualité SketchUp,

les appareils de CAO, logiciels et plus encore.

20% off all Shop products

10% off Thea Render for SketchUp

25% off Form Fonts

20% off PlusSpec

25% off Skatter

20% off 3D Connexion devices

25% off BlendUp

20% off Skalp

20% off SUbD

20% off Vertex Tools

15% off Packed Pixels devices

Free Polantis+ Account

Vous agrandissez également votre bibliothéque d'objets SketchUp au
nieme degré

avec plus de 500 textures SketchUp, 800 modeles SketchUp et 50 Styles
SketchUp

a télécharger de notre boutique gratuitement.

Upgrade Today

20
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L'Outil Décalage (Offset Tool)

“La possibilité de sélectionner seulement quelques arétes d'une face et
de les décaler au lieu d’agir sur I'ensemble de la face."

Thomthom www.thomthom.net

/

ke

Astuce : Si vous avez besoin de répéter la commande Décalage a
plusieurs endroits SketchUp se souvient de votre derniére valeur donc un
Double-Clic va répéter la commande Décalage.
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Le Menu Préférences

"J'ai découvert un "Filtre" dans la fenétre des raccourcis pour des

commandes particuliéres."

David_h

System Preferences

Coupa:;ri‘tsy Fiter I

Camera/Look Around
Camera/Match New Photo...
Camera/Next

Camera/Orbit

Camera/Pan

Camera/Parallel Projection
Camera/Perspective
Camera/Position Camera
Camera/Previous
Camera/Standard Views /Back

amars Rtandard Viewe Rattam
<

>

v

Import... Export...

Astuce : Le Menu Préférences > Raccourcis vous aussi d'importer et
d'exporter vos raccourcis clavier, ainsi il est tres facile de définir vos
raccourcis favoris sur n'importe quel support.
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L'Outil Faire Pivoter (Rotate Tool)

"Lorsque vous cliquez sur I'outil Rotation et cliquez sur le point de
rotation, ne pas lacher le bouton de la souris ...faites-le glisser vers |'axe
rouge ou vert (ou tout autre ligne que vous choisissez) puis cliquez sur
un point d’accrochage pour commencer. Cela dispense d'un plan vertical
pour obtenir la mise en place de votre rotation."

Boofredley www.boofredlay.blogspot.com

Astuce : L'outil Faire Pivoter peut également faire pivoter une copie.
En appuyant sur CTRL vous basculez en mode Copie.

23
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Le Navigateur de Composants

"Saviez-vous que si vous développez la fenétre du composant avec le
petit signe + et que vous faites glisser votre composant personnalisé
dans la fenétre du dessous, il est enregistré dans le répertoire de
composant pour une utilisation future?"

David

| maple-autumn-010

Select |edit | statistics |
_@,"] 3D Warehouse LB

maple-autumn-010
by L&#mow

» | Mo Description

In Model

| -
;3’
z%

'_j 3D Warehouse
DY TVrjomwirT

No Descrption

| -
|

yellow-birch-09 -
by Linknown
No Description
v
& trees >
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Les Commandes de Déplacement

"J'avais toujours su faire des copies multiples alignées, en entrant
simplement le nombre de copies désirées suivi par un “x".

Mais il a fallu attendre la lecture du livre “SketchUp for Dummies”
I'année derniére pour savoir que vous pouviez faire des copies multiples
régulierement espacées sur une longueur donnée en tapant le chiffre
suivi par une barre oblique. Je me suis senti stupide de ne pas avoir
suspecté cela."

Daniel

Astuce : L'astuce pour [|'utilisation des commandes de tableau dans
SketchUp est d'abord de déplacer la copie en position, puis tapez 5x
pour répéter 5 autres copies ou 5/ pour placer des copies intermédiaires
Ne pas oublier de valider par Entrer

... facile! Et tant que I'on ne demande pas une autre commande, on peut
changer autant de fois que I'on veut ses essais de multiplication!
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Le Navigateur de Composants

"Remplacer des Composants par d'autres..."

Pilou
. <
N T
’) ‘
. J
Seect |Edt | Statstcs |
S "firDrWu;huusa Ipl [+ 4
‘ ~
L o ‘
- by tinkonn
No Desoption . 1
| Properties
; —— ﬂh Delete
; by Linfo) Reload...
A Des|
[ Save As...
& . | 3D Warehouse >
I | Reset Insert Pont
Sefect Instances
Replace Selected

Astuce : Vous pouvez également remplacer les composants sélectionnés
avec quoi que ce soit de la base "WareHouse3D" !
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L'Outil Modeler (Smoove Tool)

"Maintenir MAJ en utilisant I'outil Modeler modélise suivant la
perpendiculaire a la sélection."

BTM
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L'Outil Echantillon de Couleur (Match on Screen
Color Tool)

Je viens de remarquer le bouton d’échantillon de couleur de I'écran
dans la boite de dialogue Matériaux. Jamais vu avant! Précédemment
je prenais des captures d'écran et j'échantillonnais les valeurs de couleur
dans Photoshop puis les retapais manuellement dans SketchUp."

i [Color_03

Sdect Edt |
Color

Picker: |HLS

- P
S _ IO 5’
. — [
Texture

[ use texwre imzge

I Y
- Il— }8 [T Colrize
¢ I‘l'— :IRe:etCohr

Opacity

T | [ =]

Thomthom www.thomthom.net

oj

N D me

Astuce : Le bouton d'Echantillon de Couleur vous permet aussi
d'échantillonner des couleurs de la barre d'icones et pas seulement de
I'espace de modélisation!
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L'Outil Orbite (Orbit Tool)

"Si vous étes dans un modele complexe et que vous voulez zoomer sur
une partie particuliere du modele, il vous suffit de double cliquer sur le
bouton central de la souris a I'endroit qui vous intéresse et cela centrera
ce point au centre de I'écran .... rendant encore plus facile I'usage de
I"outil orbite".

Arklandesign aka John aka Rashad

29



SketchUcation’s e The d’'Oh ! Book for SketchUp

L'Outil Faire Pivoter (Rotate Tool)

"Lorsque vous pivotez quelque chose, et survolez le rapporteur qui
apparait a I'écran, la rotation s'accrochera sur les reperes du rapporteur.

Si vous modifiez les valeurs de I'ancrage Angulaire, I'outil de Rotation
changera en conséquence.”

Broomstick

Modifier les valeurs d’ancrage angulaire : menu Fenétre > Infos sur le modéle
> Unités

30



SketchUcation’s e The d’'Oh ! Book for SketchUp

L'Outil Dimension [LayOut]

"Pour des dimensions plus rapides dans LayOut. Cliquez et placer une
cote avec |'outil Dimension puis double-cliquez sur le point suivant.
Cela divise par deux le temps nécessaire pour placer votre
dimensionnement."

Andrew Dwight www.plusspec.com

6000MmM

mm

O
0o

80

s

Astuce : Si vous maintenez enfoncée la touche ALT tout en placant la
dimension vous déverrouillez I'outil Dimension de dimensionnement

horizontal, vertical et perpendiculaire.
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L'Outil Pousser-Tirer (Push Pull Tool)

"J'ai découvert que tenir ALT + Pousser Tirer déplace une face plane
guelconque a la normale de la face."

Gruff

Astuce : Presser CTRL basculera en mode Création d'une Nouvelle
Face.
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Le Mode Transparent (Xray Mode)

"Lors de la visualisation d'un modele en Mode transparent. Si vous
maintenez la touche MAJ enfoncée tout en utilisant les outils de dessin
2D la nouvelle géométrie 2D est forcée sur la face la plus proche (le plus
proche de votre oeil.). Méme le point chaud derriére la géométrie est
projeté sur la plus proche ».

Gruff
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Le Menu Contextuel (Context Menu)

"Sélectionnez une face puis Clic Droit et sélectionnez Aligner Les Axes.
Nous I'avons tous vu, mais saviez-vous que ce que les axes créés
dépendent de la fagon dont votre face se trouve étre orientée a I'écran?

En un mot Aligner les Axes aligne I'axe de la partie inférieure la plus a

gauche."

Gruff

P e ™

Entity Info
Erase

Hide

Select

Area

Intersect Faces
Align View
Reverse Faces
Orient Faces

Zoom Selection

Make Unique Texture
Flatten Faces

en w mww
—EEEE
fmmam

B==m e N

P ="l

Astuce: Choisir Aligner la vue positionne la caméra SketchUp pour voir
directement la face sélectionnée.
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Menu Contextuel (Context menu)

"Je change les axes du modele assez souvent quand je travaille. Mais je
n'ai jamais remarqué que vous pouvez activer I'Outil Axe (ou changer les
axes a intérieur d'un composant) et cliquez deux fois (lentement)
guelque part pour que le point d’origine se place la sans changer son
orientation. habituellement, je cliquais une fois pour l‘origine, puis je
cliguais une fois pour placer chaque axe. Donc, un double-clic (lent) est
beaucoup plus rapide pour déplacer |'axe.

Chris Fullmer

--------------
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"""""""
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“raw
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-
......
........
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Astuce: En appuyant sur la touche ALT tout en changeant I'axe vous
permet de basculer I'orientation des axes encore plus rapidement.
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Adoucir Lisser les Arétes

"Je viens de découvrir, que vous pouvez appliquer Adoucir Lisser les
arétes aux groupes / composants, sans y pénétrer de sorte que vous
pouvez sélectionner tous les groupes a la fois et faire le processus
seulement une fois! Ne fonctionne pas cependant avec les groupes
imbriqués."

Plot-Paris www.sketchwork.de

Entity Info
Erass
Hide
Lock

Explode

Select 7
Aree >
Make Component...

Make Group

Intersect Faces >
Solid Tools >
Outer Shell

Reverse Faces
Flip Along
- Seften/Smqth
Zoom Selection

o Ll
s B

s ey .

C ey .
LY PR
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L'Outil Effacer (Erase tool)

"Je viens de découvrir que I'outil Gomme cache ou lisse les arétes si
vous l'utilisez en combinaison avec CTRL ou MAJ."

Broomstick

Astuce: Si vous maintenez CTRL + MAJ tout en utilisant I'outil
d'effacement puis les arétes Adoucies / Lissées vont redevenir dures.
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Menu Préférences

"Je viens de découvrir que vous pouvez utiliser plus d'une touche de
modification lors de la configuration des touches de raccourci.

Par exemple, CTRL + SHIFT + ALT + Q, ou quoi que ce soit dans ce
sens. Je n'avais jamais réalisé cela."

Chris Fullmer

Extensions/SUbD /Subdivided G
Evtancinne KL IO Misl-ama
< > Reset All |

System Preferences X
Applications y
Compatibility Filter I subd
5 sl duslved Add Shortaut
Extensions Policy Extensions /SUbD/Convert to Plain I A
Files Extensions/SUbD /Crease Tool :
General 0ns/SUbD [Decrease Subdivi: Sl
nGL :
ﬁm_ Extensions/SUbD/Entty Info s
Template Extensions/SUbD [Increase Subdivis Ctrl+Alt+/ :
Workspace Extensions/SUbD/License.... YOO |
Extensions/SUbD /Preferences/High
Extensions/SUbD Preferences/Rela
Extensions/SUbD /Preferences/Repl
Extensions/SUbD /Quad Push/Pull Tt

Import... Export... oK cancel |

Astuce: SketchUp est assez intelligent au moment de I'attribution des

raccourcis. Si vous essayez d'attribuer un raccourci déja utilisé, il vous le

fait savoir!
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L'Outil Ajouter des Détails (Add Detail Tool)

Trianguler une simple surface rectangulaire puis appliquer 'outil du Bac
a Sable> Ajouter des détails.

Pilou

e S0l PA

“ Add Detail
Add Detail

Astuce: L'utilisation répétée des Ajouter des détails créer de plus en
plus de géométrie. Essayez-le sur des terrains importés de Google Earth
et puis utilisez I'Outil Modeler pour finaliser.

Le Oh! du jour! Jamais utilisé!
Pilou
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L'Outil Ombres (Shadow Tool)

¥ Shadows
Q |u1'c4)7:uo vI

Mme F—m m— l_—'13.30 rsa|
543 A) Noon MI4DFM 2 MR
IS

Date I AWS JASUND |11/08 'I

light WSS = |30 3:
Dark  |— = |45 3:

I Us= sun for shading

Display:
W On faces
M On ground

W From eﬁes

Astuce: Utilisation From Edge (Depuis les Arétes) pour projeter des
ombres dans SketchUp est idéale pour créer des ombres pour les lignes

et cablage.
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Le Menu Fenétre ( Window Menu)

"Je viens de remarquer qu'il y a une case a cocher "Afficher les

composants imbriqués dans le modele" dans le menu Infos>
Statistiques. Voila pourquoi je ne peux pas voir mon nombre de

polygones lorsque je crée un groupe."

Ultimatez 32
Model Into
Animation 5
Casaficatons [Enﬂre model 3 [V Show nested components
Componznts _f_[—_
Credits Nam= gsouot R
Dimensons Edges
Fie Faces 18
Geo-hacation gozw‘ent Instances g
Rendzn udes
e M Gude Points 0
/ Text Grouzs 1
Lhits Images o
2d Polylnes 0
Section Planes 0
Dimersions 0
Text 0
Classification Typss 0
0
0

Clzesifizd Enttias
Component Definticns

S

Purge Unused

Fix Problems I

Astuce: Vous pouvez également utiliser le Dialogue Modele Info >
Statistiques pour Purger les objets inutilisés de votre modéle. Cela
comprend les composants, les styles, les matériaux et les Calques.
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L'Outil Rectangle ( Rectangle Tool)

'Lorsque vous utilisez I'outil Rectangle et faites le premier clic sur un
bord qui est relié a une face, I'outil Rectangle s'alignera sur le bord."

Thomthom www.thomthom.net

/

/

/

'S

Astuce: L'outil Rectangle orienté a encore plus d'un tour dans sa
manche. Si vous appuyez sur la touche ALT vous pouvez réinitialiser la
ligne de base du rapporteur permettant un contréle plus précis de I'angle
de rotation.
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Le Menu Extensions (Extension Menu)

"Quand vous avez une tres longue liste d'extensions dans le Menu
Extensions tapez simplement sur une lettre sur le clavier et vous pourrez
voir toutes les extensions commencant par cette lettre."

Pilou
e |
Extensionsp_Help
Fixit 101
Colour N-Gons
DL Camera Circle >
Profile Builder 2 Taper D va faire défiler
Drape Cpoints <— toutes les extensions
Drop Vertices... > commencant par un D
Sedus Sketch >
TIG: Reversed Face Tools... >
GKWare CabMaker >
ithil Tools >

Astuce : Certaines extensions de SketchUp peuvent choisir d'avoir un
acces dans différents endroits du systeme de menu SketchUp. Assurez-
vous en en vérifiant la documentation des extensions avant utilisation.
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Le Navigateur de Composant (Component
Browser)

"Lorsque vous créez un composant dont aucune face ne touche une
autre dans le modele avec une propriété de liaison, vous devrez le

recharger a partir du Navigateur de Composants. Le premiere créé

sur I'écran ne voudra pas coller quoi que ce soit!"
Pilou
"Mais il collera, lors de la création sur une face."

Wo3Dan

| SRS P s aEEBR
I

| ¥ Components

0 x|

Select Edt |Statistis |
Alignment

Glue to: Any 5.4
[ Cut opening

I™ Alneys Faze comera

™ shadows Face sun

Loaded From

A ; . i 2 S K [(In!unalCunponmt)

Astuce : Le Navigateur de Composant vous permet également de

changer le type de liaison d'un composant a n'importe quel moment.
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Le Dialogue Info Entité (Entity Info Dialog)

"Je viens de découvrir que dans la boite de dialogue Infos sur l'entité
SketchUp met "Solide" en face du nom du groupe pour indiquer, quand
un objet est en effet solide ... cool, non?"

Plot-Paris
_ ¥_Entity Info x]
[ Solid mponent (1 in model) 2
Laver:|Layer0 -

:‘ Name:l
Definition: | Component#1
Type;IType: <undefined> _'_I
vm;[ﬁzs.lmm’
[ Hidden [V Cast Shadows
™ Locked V' Receive Shadows

Astuce : La boite de dialogue Info entité indique également le volume
d'un objet et vous pouvez définir le type IFC également.
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L'Outil Echelle (Scale Tool)

“Je viens de découvrir cela. Prenez un cube de 10 mm, utiliser I'outil
Echelle pour étirer verticalement le cube, et il suffit de taper une
distance en ajoutant I'unité (mm, cm, m) . Cela devient la nouvelle
hauteur pour votre objet sélectionné. Vous n'avez pas besoin de lui
donner un nombre positif ou négatif pour dire de combien plus petit ou
plus grand vous le voulez. Tapez simplement la taille souhaitée. Si elle
doit étre plus petite que la taille actuelle, elle deviendra plus petite. Cela
semble plus utile sur un seul axe, mais cela fonctionne également lors de
I'échelle XYZ en méme temps."

DavidBoulder www.openstudio.nrel.gov

-

Astuce : L'outil d'échelle permet également I'utilisation de CTRL a
I'échelle par rapport au Centre et MAJ pour une échelle Uniforme.
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Le Dialogue Info Entité (Entity Info Dialog)

«En utilisant la fenétre Infos sur I'entité, vous pouvez augmenter la
longueur d'une Ligne et le nombre de segments d'un Cercle ou d'un

Arc."
Tobodo

" v Entity Info
Edge

3}

=]
-~

il_Soft [~ Smooth

A Layer:|Layer0 v
Length

™ Hidden [V Cast Shadows
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L'Outil Colorier ( Paint Bucket Tool)

"L'un de mes meilleurs moment de Oh! m'est venu quand j'ai découvert
que tout en utilisant le Pot de peinture vous pouviez maintenir la
touche MAJ pour peindre toutes les surfaces identiques ou maintenir la
touche CTRL pour peindre tout ce qui est connecté. Je I'utilise souvent."

Astuce : L'outil Pot de peinture vous permet également

d'échantillonner les matériaux de votre modele en maintenant ALT et en
cliquant sur un matériau.
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Le Menu Affichage (View Menu)

"J'ai été a la peine avec celui-ci. J'ai demandé une extension pour
basculer les lignes de guide sur ON ou OFF... c'était dans le Menu
Affichage..”

David_H

V'ew Camera Draw Tools Window Extensions Help

Toolbars... =5 = =*-F’=|
v Scene Tabs .

u Hidden Geometry H
Section Planes

¥ Section Cuts

AR

,_‘;}:”l‘?::f'i.. =
Shadows

Fog

Edge Style >
Face Style >
Component Edit >

1

Astuce : Sous Affichage> Barres d'outils, vous pouvez cliquer sur
I'onglet Options pour définir la taille de vos icOnes de la barre d'outils.

Animation
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Le Menu Edition ( Edit Menu)

"Je viens d'apprendre que Edition> Supprimer les Guides est
contextuel - il supprime tous les guides a partir depuis le niveau actuel
d’édition vers les plus profonds, mais pas dans les niveaux "supérieurs
J'avais toujours pensé qu'il supprimait tous les guides, partout.”

Jim
: Edit View Camera Draw Tools Window Extensions Help

Undo Guide Alt+Backspace
Redo Ctrl+Y
Cut Shift+Delete
Copy Ctrl+C
Paste Ctrl+V
Paste In Place
Delete Delete
Select All Ctri+A
Select None Ctrl+T
Hide
Unhide >
Lock
Unlock >
Make Component...
Make Group Shift+G
Close Group/Component
Intersect Faces >
No Selection >
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Le Menu Contextuel ( Context Menu)

"Quelque chose que je viens d'apprendre il y a quelques jours en
étudiant le modelage Google Earth en video. Oh, je ne savais pas qu'on
pouvait faire une texture unique d'une partir d'une autre

Jim

'II

Entity Info
Erase
Hide

Select

Area

Intersect Faces
Align View
Align Axes

Reverse Faces

Orient Faces
Zoom Selection
Texture

Astuce : Savez vous que si vous appliquez 2 textures différentes et que
vous masquez les bords ou les textures se rencontres, vous pouvez alors
sélectionner I'ensemble et les combiner comme textures?
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La Fenétre Styles ( Styles Dialog)

“J'ai découvert la semaine derniére que vous pouvez également avoir des
lignes de couleur dans votre modele. Cela fonctionne méme avec la
personnalisation des styles de dessin."

HFM
| » Styles I |
[ == ||pefaitstye B
@ Defeudt cobors, shaded with &
textures facestyle, white
background 4
select Edt |mx |
OO0 9 Edge
™ Edges
FBackblges
W rofies [2]
I oepthae [5
™ Bxterson Bl
I endpants [9_
I Ftter

o [oymema =] | |

Astuce : La boite de dialogue Styles vous permet de personnaliser

I'apparence de votre modele au plus haut degré. La seule limite est votre
imagination.

Bonus : L'option Couleur par les Axes est un moyen sir de trouver les
lignes hors d'axe dans votre modele. Si ce n'est pas rouge, vert ou bleu,
alors elles doivent étre hors axe!
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La Fenétre Info Sur L'Entité (Entity Info Dialog)

"Vous pouvez modifier le Rayon du Cercle via la boite de dialogue
Infos sur I'entité .. de la méme facon que vous changeriez le rayon

d'un cercle, sauf que ¢a fonctionne également si le cercle a été extrudé.'

Jeff Hammond

Astuce : La boite de dialogue Info sur I'Entité vous permet également

d'affecter I'objet sélectionné au Calque de votre choix!
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L'Outil Déplacer (Move Tool)

"Je ne savais pas que l'outil Déplacer fonctionne aussi sur des cylindres
sur un point médian Cardinal pour le redimensionner. Il fonctionne
méme sur un cone tronqué du Cardinal médian... Oh!

Wo3Dan

g

/

...----..-o.:.n-..-.-.--

Astuce : Les courbes dans SketchUp sont des éléments extrémement
puissants de la géométrie. Elles contiennent beaucoup de fonctionnalités
cachées. Essayez en dessinant un arc puis cliquer sur un point
d'extrémité et tirer..
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L'Outil Texte ( Text Tool)

“J'ai remarqué que l'outil Texte a une deuxiéme fonction pour placer une
étiquette sur I’écran : il vous suffit de sélectionnez I'outil et de cliquer
I'icone sur un endroit vide ..."

Mirale999

Copypright Me

Astuce : Pour modifier la police utilisée dans I'outil Texte il suffit de
sélectionner le texte et consulter la fenétre Info sur I'Entité. Vous
pouvez changer la couleur, la taille et bien plus encore ...
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Le Menu Affichage ( View Menu)
"La touche K fait apparaitre les arétes arrieres invisibles! Comment ai-je

pu utiliser SketchUp pendant 2 ans et ne le découvrir que maintenant?
Je me sens comme Superman maintenant avec ma vision X-ray! "

Gr8fzyl

Astuce : Avec les Arétes arrieres visibles, vous pouvez maintenant
accrocher des éléments a des endroits difficiles a atteindre.
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Le Menu Fichier ( File Menu)

"Fichier> Apercu avant Impression> Onglets de Scéne 1 a ...
Oh! J'ai toujours pensé / supposé que la sortie d'une scene était réalisé
uniquement via Fichier> Exporter 2D.”

Print Preview

~Printer

Name:

Status: Ready
Type: Canon MF210 Series

Where: USB001
Comment:

Canon MF210 Series

—Copies

Number of copies: 1 =]
—}J _J—] _}j [T Collate

~—Print Size
MV Fit to page [T Use model extents
Page size Scale

Width | 7.9 Inches ;I In the printout | 1 Inches v

Height | 4.4 Inches _v] In SketchUp | 0.3 Inches v
Tiled Sheet Print Range

: Print Quality | Draft |
@ Al
™ 2-D section slice only

" Pages from:[ 1 to: I 1

™ Use high accuracy HLR

oK

Cancel
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L'Outil Effacer ( Erase Tool)
"Utilisez I'outil Effacer pour sélectionner certaines arétes et ne pas

relacher le bouton gauche de la souris. Puis appuyer sur la barre
d'espace et relachez le bouton gauche de la souris. La sélection reste

toujours sans suppression! "

Cotty

/

'

hs

Astuce : La Barre d'Espace n’est pas seulement un endroit ou les
astronautes boivent ... .mais c’est absolument incroyable dans
SketchUp!
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La fenétre Info sur le Modeéle (Modele Info
Dialog)

"Je ne savais pas jusqu'a récemment que si vous définissez Info sur le
Modeéle> Composants> Estomper le reste du modele, en cochant
Masquer vous pouviez toujours modifier un groupe / composant, par un
triple clic pour sélectionner toutes les faces puis clic droit Intersection
avec le modeéle pour ensuite le modifier selon les besoins "

Pilou

Model Info x

Animation Component/Group Editing
Classifications
m Fade similar components

Credits
Dimensions )l [ Hide

File iak ter Darker
Geo-ocation o

Rendering Fade rest of model

Statistics ¢

Text , 4 : [ Hide

Units Lighter Darker
Component Axes

[~ Show component axes

Astuce : Vous pouvez également activer cette fonction de masquage de
la vue Menu Affichage> Modification du Composant....

Ajouter un raccourci clavier pour masquer/afficher le reste du
modeéle est super pratique
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L'Outil Déplacer ( Move Tool)
L'axe Z devient Libre avec Déplacer + ALT.

Pilou

Astuce : SketchUp appelle cette fonction Autofold (pliage
automatique) et pour vous le faire savoir le curseur passe en
surbrillance en mode Autofold.
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La Fenétre Préférences ( Preferences Dialog)

"Vous pouvez attribuer des raccourcis aux Touches "Numérigques"! Un
avantage énorme, surtout pour les gauchers."

rvioz4a

System Preferences

Camera/Image Igloo

Camera/Look Around NumPad7 =
Camera/Match New Photo... J—
Camera/Next
Camera/Orbit
Camera/Pan —
Camera/Parallel Projection
Camera/Perspective
Camera/Position Camera
Camera/Previous
Camera/Standard Views /Back

Famars iCbandard \ae Ratbam ¥

< > Reset Al |

Import... | Export... | oK Cancel |
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Le Menu Contextuel [LayOut]

"Juste découvert dans la mise en page que si vous sélectionnez un bloc
de texte puis clic droit il y a une option Ajuster la taille qui conserve la
largeur du bloc de texte, mais étend la hauteur du bloc pour afficher tout
le texte. La quantité de temps que j'ai passé a ajuster manuellement
mes zones de texte lorsque le contenu en avait été modifié!"

ype Some Textin a

Cut

Copy
e 4 Delete

Move to Layer >
Arrange >
Center >
< Flip >

Size to Fit h

Make Unbounded

Astuce : Maintenez CTRL pour créer une zone carrée de texte autour de
son centre lorsque vous utilisez I'outil Texte dans LayOut.
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La Commande copies Multiples ( Command
Array)

“J’en ai trouvé une bien bonne aujourd'hui. Copier dans une direction et
tapez 6m pour régler la distance. Puis tapez 10x pour le copier 10 fois.

Ce que je savais déja était que vous pouvez taper * 8 ou * 4 ou ce que
vous voulez pour ajuster le nombre d'éléments disposés.

Cependant, je viens de découvrir que si vous tapez ensuite 3m ou 8m il
gardera vos copies, mais ajustera les espacements. Plutot commode!"

Brodie

Astuce : Saviez-vous que la le champ de valeur (VCB) dans SketchUp
permet également de placer des objets partout dans I'espace 3D.

Il suffit de taper [20mm, 10mm, 30mm] et I'objet va a 20mm le long
de I'axe X, 10mm le long de I'axe Y et 30 mm le long de |'axe z.
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Dialogue Info sur le Modeéle ( Model Info
Dialog)

"Un truc simple, mais utile, Info sur le Modéle> Composants>
Afficher les axes des composants.”

Cotty
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L'Outil Plan de Section ( Section Cut Tool)

"Vous pouvez sélectionner la section active de I'outil Plan de section par
un double clic."

Cotty

—
——
o U

Astuce : Les Plans de section révelent également plus d'options
lorsque vous faites un Clic Droit sur |'un d’eux.

Vous pouvez créer une tranche, extraire la géométrie et Inverser le
sens de coupe!
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La Fenétre Structure ( OutLiner Dialog)

"Je viens de découvrir par hasard que vous pouvez faire déplacer des
groupes et composants imbriqués les uns dans les autre et qu'ils
conservent leurs positions."

Tobodo

_ ¥ Outliner i
Flter:l D
Untitled

* 8t <Component®4> .
-8 <Component#5>

- 18 [<Coonoearzl)

Astuce : La boite de dialogue Structure a également un filtre génial
pour localiser quoi que ce soit dans un groupe ou composant. Si vous
Double-cliquez sur I'élément dans la Structure il devient prét a étre
édité dans SketchUp.
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L'Outil Déplacer ( Move Tool)

"Je ne trouvais rien pour déplacer des sommets dans SketchUp. Et
encore moins sur la facon de verrouiller le déplacement d'un sommet
dans la direction d’une aréte.

J'ai découvert que si vous survoliez sur I'aréte d'abord puis maintenez
MAJ alors ensuite vous pouvez déplacer le sommet dans l'alignement de
cette aréte."

Wo3Dan

Pour sélectionner un sommet il est important que rien ne soit sélectionné avant
dans le modéle. L’outil Déplacer sélectionnera automatiquement le sommet sur
lequel vous cliquez
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La Barre d'Outils ( ToolBar)

"J'ai eu un Oh! d’étonnement I'autre jour ... Je viens de découvrir l'icone
Créer un Composant dans la barre d'outils! Quand cela a été ajouté?
Toutes ces années a passer par le Menu Edition > Créer un
Composant.”

Daniel

|

v Make Component

Make a component fromthe selecied
entities,

oNem\ ¥~

I kﬁ\aygﬂ'&l
ARER LPEY APDE Y6 H Y

FE T E

= =
<93

Astuce : Créer un composant a été crée depuis SketchUp 2. C'était a la
version 2.014!
Sinon Clic Droit sur L'objet / Créer un Composant // Groupe!

Et encore plus rapide : touche G
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La Boite de valeur ( VCB)

"Tout le monde sait que nous pouvons entrer une valeur dans les deux
unités métriques et impériales quelle que soit les unités du modele par
défaut. Mais je viens de découvrir que nous pouvons également
combiner les deux systemes d’unités!"

Flashy

«Vous pouvez mettre a I'échelle un cube dans les 3 directions a des
dimensions précises en appliquant 1m;10’; 12" puis presser Entrer. "

Wo3Dan
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Le Menu Contextuel ( Context Menu)

"Si vous sélectionnez plusieurs instances du méme composant et utilisez
Rendre Unique, ces instances vont toutes devenir des instances du
nouveau composant.”

Cotty

5 identical components

|
| |

A \ \[y By
L b | I

Entity Info
Erase
Hide

Lock

Edit Component

T SN | e
Unique

Explode

Unglue
Reload...

Make Unique creates 2 new identical components

70



SketchUcation’s e The d’'Oh ! Book for SketchUp

Verrouiller L'Inférence

"A cette époque I'année derniere, j'ai découvert qu’en appuyant sur les
touches fléchées on verrouille I'axe de déplacement ou de la copie
d'objets. Maintenant, j'utilise les fleches religieusement."

Cotty

Astuce : Dans SketchUp les fleches activent le verrouillage des
inférences.

Pour verrouiller I'axe Z appuyez sur la Fleche Haut, pour verrouiller
I'Axe Rouge la Fleche Droite, Pour verrouiller I'Axe Vert la Fleche

Gauche et pour verrouiller sur une inférence hors axe appuyez sur la
Fleche Bas.
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Le Menu Contextuel ( Context Menu)

"Dessiner un cercle, sélectionnez la circonférence et Clic Droit Diviser!
Pilou

N

Astuce : La fonction Diviser ne fonctionne que sur les Arétes, des
cercles et des Arcs.

Cette fonction est aussi tres pratique pour calculer a I'avance une copie
multiple entre 2 points car elle affiche le nombres segments et la distance
entre chaque segment.
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Les Outils Solides (Solid Tools : Pro)

"Je remarque seulement aujourd'hui qu'avec les outils Solides, si vous
soustrayez un solide transparent d'une autre forme, il laisse derriére lui
des faces transparentes. Je suppose que je dois surtout peindre apres
ces opérations effectuée.”

S Shepherd

BrBnBne

Y
Subtract first solid from second and
keep only the result in the model.

Astuce : Les outils Solides sont des opérations booléennes qui ajoutent,
soustraient, coupent, fusionnent ou intersectent des objets solides.
(version pro seulement)

Il y a aussi I'outil Enveloppe qui est idéale pour I'impression en 3D.
(toutes versions)
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La fenétre Ombres ( Shadows Dialog)

"Quand vous avez un groupe ouvert et que tout le reste est estompé et
difficile a voir, vous pouvez cocher utiliser le Soleil pour les ombres.
Le reste du modele est ainsi plus facile a voir.

J'aime cette option quand je veux que mon groupe ouvert fasse
référence a d'autres parties du modele.

P Molson

Astuce : Dans SketchUp, utilisez le Soleil pour les Ombres pour
simuler des parties de votre modele dans I'ombre méme si les ombres
sont désactivées.
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L'Outil Dimensions ( Dimensions Tool)
"La puissance des <>"
Pilou

"Et \ n pour le retour a la ligne”

| <>\nText| 422.6mm
' ‘ Text ’,

Wo3Dan

Astuce : 'outil Dimension de SketchUp vous permet de modifier le
texte dans la dimension si vous double-cliquez dessus. L'utilisation des
symboles "<>" maintient votre dimension et "\ n" ajoute une nouvelle
ligne.

Bonus : Avec un clic droit sur une dimension dans SketchUp, vous
pouvez accéder a la fonction de la position du texte.

Egalement, si vous utilisez I'outil de Dimension sur un cercle ou un arc,
vous pouvez basculer la dimension sur diametre ou sur rayon.

75



SketchUcation’s e The d’'Oh ! Book for SketchUp

L'Outil Zoom (Zoom Tool)

"Je viens de découvrir la roue ...

L'utilisation de deg ou mm lors du réglage de la distance focale de la
caméra, peut basculer entre la distance réelle de la focale en millimetres
et champ de vision mesuré en degrés.”

Derei

| Field of View 45deg |

0

Astuce : Maintenez MAJ tout en faisant glisser |'outil Zoom pour ajuster
visuellement le champ de vision.
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La Barre d'Outils (Tools Bar)

“J’en ajoute un que j'ai découvert I'autre semaine par pur hasard. Faites

un Clic Droit sur une barre d'outils pour voir une liste de toutes les

barres d'outils chargées et déchargées.”

Pixero

ONW@RmN\
e W W W)

O <
L WS

B

<<

Curviloft

Drawing

Dynamic Components
EDG3D

Edit

ExtensionStore
FlirGen

Fredo6 Tools
Fredo6_Animator
Fredo6_FredoScale
Fredo6_JointPushPull
Getting Started

Astuce : Les barres d’outils peuvent occuper une place importante dans

Sketchup. Savoir activer et désactiver les barres d’outils vous rend plus
productif et vous fait gagner de la place pour admirer votre travail.
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Aspect Juridique

SketchUcation est une marque déposée de SketchUcation LLC., Enregistrée en République
d’Irlande.

L'illustration de couverture Copyright © 2016 par SketchUcation LLC
Les Illustrations © 2016 SketchUcation

Bien que I'auteur et I'éditeur aient fait tous les efforts pour veiller a ce que les informations
contenues dans ce livre soient corrects au moment de la parution, 'auteur et I'éditeur se
désengagent et déclinent toute responsabilité envers toutes parties pour toutes pertes,
dommages ou perturbations causées par des erreurs ou des omissions, que ces erreurs ou
omissions résultent de négligences, accidents, ou toute autres causes.

Pour plus d'informations sur nos produits ou services, veuillez s'il vous plait contacter notre
service clientele a
support@sketchucation.com.

Aucune partie de cette publication ne peut étre reproduite, stockée dans un systeme de
récupération ou transmise sous quelque forme ou par tout moyen, électronique, mécanique,
photocopie, enregistrement ou autre, sans autorisation préalable de SketchUcation.
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